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1. Introduction. 

The VO2max Tracker ergospirometer is a stationary system designed to perform 
exercise tests of the respiratory and circulatory systems, and offering a comprehensive 
analysis of the measurements taken. The VO2max Tracker measuring system is 
designed based on a pneumotachographic head patented by MES and quick carbon 
dioxide and oxygen analysers that support measurements taken using the “breath by 
breath” method with an analysis of each exhalation phase. The system may be 
equipped with a mixing chamber as an option.  
Due to the application of an advanced pneumotachographic head, the measuring 
system does not require any inhalation-exhalation valve nor any connections made 
e.g. from corrugated tubes. This ensures the full comfort during tests, because the 
examined patient breathes under natural conditions without any additional resistance 
to air flow. The integrated spirometric examination module with unique software 
offering reliability checks of completed tests, according to the recommendations of the 
ERS/ATS, enables the user to determine the FEV1, MEF50 and VC values, eventually 
used as a basis to automatically determine the normal values for HR, VO2 and VE 
measured in exercise tests. 
VO2max Tracker supports continuous recording of the following signals as a function 
of time: tidal volume, respiratory flow, O2 and CO2 concentrations in the exhaled gas, 
1 – 12 ECG leads. The system always archives the full examination procedure, enabling 
the user to reproduce each exhalation. The method of presentation of the procedure 
during its performance and the printout of measured changes and calculated values is 
defined by the operators. 

Advantages of the VO2max Tracker system: 
- works with the VO2 Viewer program 
- examinations using the “breath by breath” method 
- a light, low-resistance pneumotachographic head without movable 

components 
- an automated ambient condition measuring system 
- an automated gas analyser calibration system 
- alternative methods available to measure the heart rate in a wireless system or 

with 12 ECG leads 
- automated or manual determination of the anaerobic threshold 
- possible VO2max determination 
- measured quantities displayed as compared to normal values 
- automated control of treadmills or bike ergometers 
- the printout layout of the report on test results may be edited 
- the report on an examination may be transferred to standard statistical 

programs 
- software compatible with Microsoft Windows 
- easy transport of the system mounted on a trolley 
- the measuring system may be extended by additional options: pulse oximetry, 

minute cardiac output using a non-invasive method, measurements of systolic 
and diastolic pressure values. 
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The VO2max Tracker system consists of the following components (Fig. 1a): 
1. Carry case  
2. 3-litre syringe for flow and volume calibration (in the optional carry 

case) 
3. Wear belt system for  main unit 
4. POLAR heart rate sensor 
5. Main VO2max Tracker deice 
6. Telemetry radio receiver (optional) 
7. Telemetry radio transmitter (optional) 
8. A stand for the cylinder (optional) 
9. A CD-ROM with the VO2 Viewer program 

 

 

Fig. 1a. VO2max Tracker Ergospirometer with accessories 

 
 
 
 
 
Basic equipment necessary for performing of the examination consists of the following 
parts (Fig. 1b): 
 

1. Headgear for the mask 
2. Ergospirometry  mask 
3. Mask adapter 
4. Pneumotachographic headpiece 
5. Head coupler with built-in flow sensor 
6. Polar HR transmitter 
7. Gas tube with connectors 
8. Main Tracker device 
9. USB cable for PC connection 
10. Rechargable batteries AA type – 4 pcs 

 
 

I 
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Fig. 2b. VO2max Tracker Ergospirometer with basic equipment for examination 

 
 
 
 
The VO2max Tracker ergospirometer is equipped with the following sockets and 
components (Fig.1c):  

 
1. “Flow Port” Socket (blue) connection with patient’s cable and pneumotachgraphic 

headpiece 
2. “Main Port” Socket (black)  connection with PC Cable or the terminal Transmitter 

module  
3. Gas IN Socket (Luer Type) for gas tube connection 
4. ON/OFF button to switch on power supply. (Hold at least 3 seconds until all the 

leds turn off apart of the blue one (BT). To turn VO2max Tracker off hold the 
button again for at least 3 seconds. 
If the device is turned on at least 45 min. and no examination is performed, it will 
turn off automatically. 
 

5. Three light diodes: ST, BT, BR and HR 
Diode ST-Status informs about the battry status: 

  Continuous red colour- informs about low level of battery or no-battery 
  Continuous Green colour – battry level is OK 
  
Attention! 
 If the battery level is poor, the device will give the sound alarm (double-tone). Now the 
user has time to replace the batteries for fresh ones opening the battery compartment. 
VO2max Tracker has it own internal battery witch can hold the power up to 30 seconds. For 
safety it is better to replace batteries one by one instead of putting all of them out. 
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Diode BT – Bluetooth status 
 Blinking blue (long ON/short OFF) – ready for connection 
 Blinking blue (short ON/long OFF) – patient cable disconnected 
 Continuous blue – connection is ON 
Diode BR – Breath Rate is on during expiration phase of breathing patient 
 
Diode HR – Heart Rate Status – starts to blink, when the connection with Polar belt 
transmitter is successful.   .  

 
 

 

 
Fig. 3c. VO2max Tracker Ergospirometer – connection panel view 
 
 
The VO2 Viewer program working with the VO2max Tracker ergospirometer 

enables the user to complete an ergospirometric examination. The interface view is 
shown on Fig. 4. The program enables its user to determine the following parameters: 

 
BF [1/min]  breathing frequency;  
HR [1/min]  heart rate per minute; 
MET = VO2/kg/3.5  a metabolism unit (1MET=3.5ml/min/kg); 
VE [litre/min]  minute ventilation –  the volume of air used by the patients 

to ventilate their lungs during 1 minute. The parameter is 
calculated as the product of the number of breaths (BF) and 
the volume of a single breath (TV) measured in the 
exhalation phase. BTPS conditions. 

RER = VCO2/VO2  respiratory exchange ratio;  
TE [s]  exhalation time; 
TI [s]  inhalation time; 
TTOT [s]  duration time of the full breath cycle; 
TV(VT) [litre]  volume of a single breath; 
VO2 [litre/min]  oxygen consumption converted into the STPD conditions; 
VCO2 [litre/min]   exhaled carbon dioxide converted into the STPD 
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conditions; 
FeO2 [%]  mean value of oxygen concentration in the exhaled air (the 

value is calculated as FeCO2); 
FeCO2 [%]  mean value of carbon dioxide concentration in the exhaled 

air. The value is calculated for each exhalation phase, and 
when averaged for a selected time interval, it is computed 
as a mean value of all mean values of full exhalation phases 
in the selected time interval.  

EQO2 = MV/VO2   ventilation oxygen equivalent; 
EQCO2 = MV/VCO2  ventilation carbon dioxide equivalent; 
TI/TE [%]  ratio of the inhalation time to the exhalation time; 
TI/TTOT [%]  ratio of the inhalation time to the time of the entire cycle; 
VO2/HR [ml]   oxygen consumption relative to heart rate per minute;  
VO2/Kg [ml/kg/min]  oxygen consumption per 1 kg of patient's body weight 
VO2/Kg/HR [ml/kg]  oxygen consumption per 1 kg of patient's body weight and 

unit of heart rate; 
WATT [W]   workload; 
  
SpO2  saturation (blood saturation with oxygen); 
VD/VT  ratio of the residual volume to the tidal volume 
PEO2 [mmHg]  averaged partial pressure of oxygen in the exhaled gas; 
PECO2 [mmHg]  averaged partial pressure of carbon dioxide in the exhaled 

gas; 
BR [%]  breathing reserve; 
VET_SUM [L]  ventilating air volume; 
TV_TE [L/s]  ratio of the TV to the TE parameter; 
Speed [km/h]  treadmill speed; 
Slope [%]  treadmill slope; 
SBP [mmHg]  value of systolic blood pressure; 
DBP [mmHg]  value of diastolic blood pressure; 
Borg  twenty-point Borg scale used by the patients to describe 

their perceived exertion; 
 
 

Points Exertion 

6 Extremely light 

7 

8 Very light 

9 

10 Rather light 

11 

12 Rather hard 

13 

14 Hard 

15 

16 Very hard 

17 
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18 Extremely hard 

19 

20 

 

Lactate [mmol/l]  the value of blood lactate concentration; 
 
Quantities describing the oxygen debt (EPOC): 
 
VE.B.SUM [L]  the total volume of breaths during the test calculated at the 

reference phase level (tare); 

VE.T.SUM [L]  the total volume of breaths in the entire test; 
VE.L.SUM [L]  the total volume of breaths in the exercise phases; 
VE.R.SUM [L]  the total volume of breaths in the recovery phase; 
VO2.T.SUM [L]  the total volume of oxygen consumed during the entire test; 
VO2.OD.SUM [L]  the difference in the oxygen consumed during exercise phases 

between the consumption values rounded to the end-phase 
level and actual values; 

VO2.L.SUM [L]  the total volume of oxygen consumed during the exercise 
phases; 

VO2.R.SUM [L]  the volume of oxygen consumed in the recovery phase; 
VO2.A.SUM [L]  VO2.A.SUM = VO2.OD.SUM - VO2.R.SUM; 
VO2.B.SUM [L]  the volume of oxygen consumed during the test calculated at 

the volume of consumption from the reference phase; 
Explanation of acronyms STPD, BTPS, ATP used: 
STPD  Standard Temperature Pressure Dry (dry gas conditions at a 

temperature of 0 oC and a pressure of 760 mmHg); 
BTPS  Body Temperature Pressure Saturated (human body 

temperature, atmospheric pressure and steam saturated air 
humidity); 

ATP 
 

 Ambient Temperature Pressure (temperature, humidity and 
pressure conditions in the room where the test is 
performed). 

 
 

1.1. Technical data.  

General data: 
Dimensions (length/width/height)  150/100/55 mm 
Weight                   280 g 
Supply voltage              rechargeable batteries 4 x 1,2 V AA Ni-MH 

 
Bettry Charger: 
 Supply voltage     230-240 V AC, 50Hz 
 Number of loaded batteries   4 
              Power consumption    1,5W 
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Technical data of the measuring module: 
 

Flow measurement: 
Measuring headpiece:   MES DV40 (or DV40e) 
Dead space:    38 ml (or 20ml) 
Flow range:    +/- 20 l/s 

 Flow resolutions:   1 ml/s 
             Usable flow resolutions:  10 ml/s 

Volume measurement range:  0 - 10 l (0 – 20 l) 

Usable volume resolution:  10 ml 
 Accuracy:    < 2% 
 Headpiece resistance:   < 0,9 cmH2O/l/s (at 14 l/s flow rate) 

Ventilation range:   300 l/min 
 

Oxygen analyser:   electrochemical cell 
CO2Meteor (UV flux sensor) 
Measurement range:   0 – 25 % (0 – 100 %) 
Response time:    t90 < 100 ms  
Accuracy:     0,01 % 
Resolution:    0,01 % 
 
Carbon dioxide analyser:          NDIR infrared absorption 
CozIR SprintIR (infrared) 
Measurement range:   0 – 10%(0 – 15% expanded range) 
Response time:    t 90 < 100 ms  
Accuracy:     0,01 % 
Resolution:    0,01 % 
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2. Installation 

The VO2max Tracker set must be correctly installed to successfully perform an 
examination. The installation process consists of the following steps: 
 
To perform the examination properly, you need to install the VO2max Tracker software 
properly. Installation consists in the following steps: 
 

1. From the attached CD-ROM install VO2 Viewer program on the computer: 
 Start the setup.exe file in order to launch the VO2 Viewer  program 

installer. Install the program 
 

2. Connect the USB cable with black plug to “Main Port” of the device. The other end 
of the cable with USB plug must be plugged to your PC. 
3. Your system will ask You for drivers to the USB Adapter. If You are connected to 
the internet, You may try to allow automatic installation. If not, you have to find the 
drivers on installation PC* 
 
4. Connect the patient cable with blue plug to the “Flow Port”. The gas cable 
(transparent tube) has to be plugged to “gas in” plug. 

 
5. Perform the examination according to the description from Chapter 7. 
6. When there is a communication breakdown between the computer and the 
ergospirometer, one should check the cable connections to the ports (Chapter 5.3) 

 
 
 
*Caution: 
After installation and connecting the USB/COM adapter, it is necessary to check the 
COM number of the adapter. All You have to do, is to find a “Device Manager” in Your 
Windows system, find “COM/LPT ports”. The title You are looking for is “USB-to-serial 
comm Port” Write down the COM number. You will need it to set up “The hardware 
configuration” of “Ergo2000M” software. 
 
 

2.1. Connecting and disconnecting the cables  

The device is equipped with smart and easy-to-use connections. However, please pay 
attention to proper and gentle handling of the “FLOW PORT” plug and “MAIN PORT” 
plug. 
 
Connecting: 
There is only one position, that you can plug the cable to the socket. There is a special 
notch on the end of the plug, also signed with additional arrows (see the pic below). It 
must fit to the similar notch inside the socket. After you match them, just push gently 
the plug into a socket, until you hear and feel the “click”. 
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Fig 3d: Connecting the cable 

 
Disconnecting: 
Gently push the plug outside the socket in parallel to the cable.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig 3e: Disconnecting the cable 

 
WARNING! DO NOT TRY TO SCREW THE PLUG. Doing so may damage the plug or/and 
the socket.   
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3. Program interface description 

 
Fig. 4. Program interface view. 

Sample program window view is shown on Fig. 4. It consists basically of several 
sections constituting separate windows. Each window may contain a chart, data table, 
digitally displayed parameter, or needle indicator. The dimensions of each window 
may be changed, and each window may be removed at any time. 

The parameters, normal values displayed in each chart may be modified at any 
time, similarly the chart graphic properties (using additional settings). Selected chart 
fields may be enlarged or reduced during the examination using the scroll wheel 
(mouse wheel). 

The table shows data collected during the examination in the “breath by 
breath” mode, i.e. each table row corresponds to one breath. The row values may 
averaged for any time interval. The table columns represent specific parameters during 
the examination time for each breath. The columns may be modified at any time, by 
adding or removing parameters and changing their order or sequence. 

The displayed window and table configuration is permanently saved in the 
“View”. A dozen ready views are available. They may be modified and saved, and 
customized views may be created. 
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4. Patient's data 

The patient's data is a set of information necessary to identify the patient. No 
test may be performed without this information. The patient's data may be entered 
using two methods: 

1. Entering new patient's data ( Section 4.1). 
2. Selecting a previously entered patient from the list ( Section 7.3). 

Once patient's details are entered, the test is performed for this patient. To examine 
another patient, those patient's data must be entered in advance. 

4.1. New data 

To enter new patient's details, display the patients' list (the “Patients” button) 
or use the “New examination” button.  

 

If the first method is selected, the patient may be added to the list and the user 
may return to other tasks. If the second method is selected, the patient is entered or 
selected from the list and then the program automatically proceeds to performing the 
examination. 

The “Examinations” button is used to display a list of all tests previously 
performed and to browse and edit the tests. 

 

A series of options are available upon entry in the list of patients: 

 

 

 New examination – beginning a test for the patient marked in the list 

 Add new – adding a new patient to the list 

 Cancel – exit from the patients' list 

 Examinations – displaying tests performed only for the marked patient 

 

If the “Add new” button is used, the Patient dialog box is displayed ( Fig. 5). 
The box contains a set of fields where information is entered according to the labels 
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located next to each field. The BMI index is automatically calculated once the patient's 
height and weight are entered. 

 

Fig. 5 The Patient's data dialog box. 

4.2. Modifying 

The patient's data may only be modified until the beginning of the examination. 
Erroneous details entered and approved may be corrected after starting the 
examination only if the examination is closed. Enter correct details then, following the 
procedure for entering a new patient ( Section 4.1).  

The patient's data may be modified prior to commencing an examination, using 
the Patient dialog box ( Fig. 5), and selecting the desired item in the patients' list. 
Any detail may only be modified if it is previously entered ( Section 4). All patient's 
details may be modified. 

4.3. Data review 

The patient's data may be reviewed when the patients' list is displayed and the 
patient is then selected in the list. 
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5. Program options 

Program options represent information necessary to correctly perform an 
examination. This information describes parameters of data transmission between the 
ergospirometer and the computer, and the ergometer selected. The use of exercise 
protocols differs, depending on those settings. If a test with an ECG device is selected, 
the procedure of examination start and performance may change. 

 

 

5.1. Ambient conditions 

Once the Ambient conditions command is selected, the device will display a dialog 
box describing the external conditions prevailing during the examination ( Fig. 6). 

 

 
Fig. 6. Weather conditions. 
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If no values or incorrect values of parameters representing the temperature, humidity 
and pressure are entered, the examination results may become inaccurate and 
unreliable. The values may be entered manually, as read from external devices (a 
thermometer, a barometer, a hygrometer) or may be read automatically. Connect to 
your computer a special extension module designed for weather condition reading, 
and (having executed the VO2 Viewer program) select the Automated readings field. 
The COM serial port window will be activated where the port number with the 
extension module connected should be selected. Click on the Read now button to have 
the current weather conditions read and their values entered in the dialog box. The 
values may be updated both prior to and after the selection of the examination type. 
They are valid for 4 hours. This means that the program will not request that the 
weather conditions be updated for 4 hours, regardless of the number of program 
starts in this period (be it one or more). 

 
 

5.2. Calibration 

When the Calibration command is selected in the Program options, you must 
select whether the calibration process applies to the gas or the volume. If the program 
is executed with outdated weather conditions, a dialog box will be displayed 
requesting their refreshment ( Section 5.1). Enter current temperature, pressure and 
humidity values or select their automated reading (if the extension module for 
automated condition readings is available). Gas and volume calibrations are valid for 
24 hours. The calibration process is completed under ATP conditions. 

5.2.1. Volume calibration 

When the Volume calibration command is selected in the Program options menu 
and the prevailing weather conditions updated, if required, the dialog box shown on 
figure Fig. 7 will be displayed. 

 

Fig. 7. Volume calibration. 



VO2max Tracker System User Manual 
. 

 19 

The Calibration manoeuvres window is used to enter the number of correct 
movements of the calibration pump piston necessary to finalize the calibration 
process. The irregularity of pump piston movement is checked in the calibration 
process. If the irregularity value is excessive, the program will reject the manoeuvre 
with the set percentage value of irregularity exceeded. A previously accepted 
manoeuvre may thus be rejected. The Capacity field is used to enter the capacity of 
the calibration pump used. Certainly, the calibration pump must be connected prior to 
the calibration process to the spirometric head that is correctly attached to the air 
conduit coupling. The calibration process is initiated using the Start button and 
producing uniform movements of the calibration pump piston. The Calibration 
coefficient field displays the most recent correct calibration coefficient and the 
Number of uniform manoeuvres shows the number of movements accepted by the 
program. The manoeuvre volume window displays bars with their heights 
corresponding to the volumes of manoeuvres completed. The number of bars is 
consistent with the number displayed in the Number of uniform manoeuvres field The 
bottom section of the window contains a field displaying “hint messages” facilitating 
the calibration process. If this field shows a message saying that the calibration process 
has been correctly completed, the volume calibration process is finalized. 

 

 

 

 

 

 

 

 

 

5a. Plugging the headpiece to the air-tube connection 

 

 

 

 

 

 

 

 

5b. Headpiece connected to the air-tube 
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5.2.2. Gas calibration. 

The gas calibration dialog box ( Fig. 8) is displayed when the Gas command is 
selected in the Calibration sub-menu of the Tools menu.  

 

Fig. 8. Gas calibration. 

This calibration process may be summarized by the following steps that must be taken 
in their precisely defined order: 

Enter percentage concentrations of O2 and CO2 in the reference gas in the Reference 
gas parameters group (using the description on the cylinder with calibration gas). Any 
changes may only be entered following the connection of a new cylinder with a 
reference gas. 

In the Sample gas parameters group one should enter the O2 and CO2 concentration 
percentage in the sample gas (description on the calibration gas cylinder). Changes can 
be made only after connecting a new sample gas cylinder.  
After clicking the Start button there appears information that 'zero' will be read from the 
atmosphere. One should make sure that the end of the silicone gas cable (by the head 
connector) is 'let out' to the atmosphere. Then we confirm this with the OK button.  
For the next 30 seconds 'zero' will be read from the atmosphere. In the meanwhile, you 
may prepare the bag with calibration gas: 
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- Squeeze the bag to remove an atmospheric weather from the inside (see the photo 
below) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6a. Sqeezing the calibration bag 

 
 

- connect the bag to the bottle, and gently open the valve. Fill the bag with small 
amount of the gas (see photo below) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6b. Filling the calibration bag with gas 

 
- squeeze the bag again 

- fill the bag with a gas (more than previous) but not as much as a “balloon” 
 
After reading 'zero', the program will inform us that the sample gas calibration will be 
conducted. It is time to connect the bag with the calibration gas (if it is not already 
connected) to the “Luer” nut at the end of the transparent-blue gas cable.  
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6c. Connecting the calibration bag to the air-tube 

 
 
 
 
 
 
Let the device vacuum the gas from the bag. Do not squeeze a bag or silicone tube. 
 
The connection is confirmed with OK button. The proper calibration process lasts also 
around 30 seconds. During the process the following information are displayed in the 
window: 
In the Currently read concentration group there are displayed the currently read 
concentrations of the proper gases. 
In the O2 – cylinder reading and CO2 – cylinder reading columns are drawn whose height 
corresponds to the values from the Currently read concentration windows.  
At the bottom there is a field where the 'prompting messages' are displayed that facilitate 
the process of calibration. When in this field appears information that the calibration has 
been completed successfully, the process of gas calibration is finished.  
In the Calibration Factors field the calculated calibration factors are displayed.  
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5.3. Configuration 

When the Configuration command is selected in the Options menu of the program, 
a dialog box is displayed in the left section of the screen, with several tabs. They 
include (in sequence): 

 

 General 

 Devices 

 Company 

 Comments 

 Parameters and norms 

 Protocol 

 Respiratory cycle examination 

 

The following subsections describe each of the tabs. Any changes made must be 
confirmed using the "Save" or "Save and close" buttons, if not prompted in advance by 
the program. 

5.3.1. The General tab 

 

Fig. 9. The General tab 

This tab is used to select the language (Polish or English). The language is changed in 
the entire program, excluding draft reports that must be set by the users, depending 
on their preferences. 

The Console window is designed for authorised service staff. It has no functionality at 
the user level. 



VO2max Tracker System User Manual 
. 

 24 

 

5.3.2. The Devices tab 

 
 

 

Fig. 10. The Devices dialog box 

In this tab, the user may select from the list a device to be currently used in the 
test (the “Active” parameter), and assign the COM port number to the device. The 
number may be read in the system Device manager, in the “COM&LPT ports” branch. 
Each device has one number assigned, except VO2max Tracker that is supported by 2 
COM ports. 

In addition to the ergospirometer, the type of ergometer is set here 
(bike/treadmill) as well as work with an ECG system, if this additional option is 
available. If the “Polar” system receiver is used, it must be marked and an appropriate 
COM port must be assigned to the receiver. 

The “Treadmill WATT parameter” can be seen in the bottom section of the 
screen. It is used to select the method for theoretical calculation of workload in watts, 
based on the treadmill speed and slope. 3 methods are available: 

 
 
 

  JAEGER: 
 

 for running:  
W [Watt] = (V * BW * (2.11 + G * 0.25) + 2.2 * BW - 151) / 10.5 

 for walking: 
W [Watt]= (V * BW * (2.05 + G * 0.29) + 0.6 * BW - 151) / 10.5 

 

 ATS: 

G = 100 * tan   

W [Watt] = BW * V * sin  * 100 / 36.4 
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 BRUCE: 

tan   sin     for small ones   
W [Watt] = BW * V * G / 36 

 
The acronyms used in the above equations have the following meanings: 
BW – weight of the examined patient [kg] (EN Body Weight) 
V – treadmill speed [km / h] 
G – slope [%] 
W – workload [Watt] 
 

 
 
 

5.3.3. The Company tab 

 

 

Fig. 11. The Company tab 

This tab is used to enter the parameters of your centre or another centre where 
the tests are performed. The details will be shown on report printouts. Completing all 
rows is not mandatory. 

 

5.3.4. The Comments tab 

 
 This tab is used to enter standard comments that may be then used in 
examination report printouts. 
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5.3.5. The Parameters and norms tab 

 
Fig. 12. The Parameters and norms tab 

 
This space is used to define new parameters and norms for a test. Those changes may 
only be made by authorised service staff. 
 
The source of heart rate reading (HR) in the “Devices” column may be changed from 
the user level, if this change is necessary. The program usually automatically identifies 
the source device of the HR parameter. 
 

5.3.6. The Protocol tab 

 
This tab is used to create and edit exercise protocols that are necessary to operate the 
ergometer with the aim of enforcing patient's physical workload as required to 
perform an exercise examination. The tab is irrelevant in the case of examinations with 
an ECG system that automatically defines a workload as a master program. It is also 
irrelevant if no ergometer is selected in the “Devices” tab. 
 

 
Fig. 13. The Protocol tab 

The list displays default, standard protocols, used in exercise examinations. They 
include both treadmill protocols (with the "Run” extension) and bike ergometer 
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protocols (with the "Bike” extension). Also alternative protocol versions are available, 
such as "Ramp” with a linear increase in workload during the examination. 
It should be emphasised that protocols designed for a treadmill only or a bike only may 
be selected prior to the examination. 
 
To edit the selected protocol, click twice on the grey square located to the left of the 
protocol header. A window for editing and designing exercise phases will be displayed. 
 

 
Fig. 14. Editing protocol phases 

 
The following fields are to be completed: 

 Name – the name of the protocol to be displayed during the examination 

 Description – an auxiliary comment to the protocol name 

 Device – define here whether the test phases are designed for a treadmill or a 
bike. Various column layouts are displayed in the table below and various 
workload calculation methods are used by the program during the test, 
depending on this setting. An exercise protocol is selected from the list 
displaying protocols for a treadmill only or for the bike only, depending on the 
device set in the program prior to commencing the examination. 

 
 
Below you will also find a table where each row corresponds to one exercise phase. It 
contains the following columns: 
 

 Name – the name of the phase displayed during the examination 

 Order – a parameter of key importance. It enables the user to change the 
sequence of phases and define their meanings. Numbers -1 and 0 represent 
special phases. Phase -1 always represents an initial control phase when the 
patient is prepared for the test and the correct calculation of basic parameters 
is checked. Once the user proceeds to the next phase, the data from phase -1 
is deleted and is not saved in the test results. Phase 0 always represents the 
rest phase. The examination begins with this phase. To correctly compute 
certain parameters (e.g. calorimetry), the phase should be set to at least 3 
minutes (180 seconds). The phase is set to a longer time in most protocols, and 
the user is free to decide when to proceed to the exercise phases. 

 Time – phase time given in seconds. If this time expires in the current phase, 
the program automatically proceeds to the next phase. The user is enabled to 
skip to the next phase or to the last phase at an earlier time. 
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For a treadmill: 
 

 Slope – the initial value of inclination for the defined phase in percent [%] 

 Final slope – the final inclination value, computed automatically. If the 
workload is constant, it is equal to the value in the “Slope” column. If the 
“Slope increase” columns are used, the value is calculated based on those 
columns and the phase time. Selected treadmills 

 Slope increase 

 Slope increase (s) 

 Speed 

 Speed final 

 Speed increase 

 Speed increase (s) 
 
For a bike ergometer: 
 

 Workload 

 Final workload 

 Workload increase 

 Workload increase (s) 
 

5.4. Examination options 

 
The system enables its user to perform two main types of examinations: 

 An ergospirometric test 

 A combined test (ergospirometry and exercise ECG) 
 
The program operation depends on the devices selected in the Devices tab (Section 
5.3.2). If the selected devices include an ECG, each commenced examination will 
automatically be set to the combined examination test. The ECG operating program 
takes then the functions of a master program managing exercise protocols, controlling 
ergometer parameters and reading the heart rate. The VO2 Viewer program is used to 
execute the “commands” from the ECG program. 

5.4.1. An ergospirometric test 

If only an ergospirometric test is to be performed (without ECG 
measurements), the “New examination” must be selected on the main screen. The 
program transfers us to the patients' list where a patient may be selected or a new 
patient added using the “Add new” button. A new patient may also be entered without 
initiating an examination, by entering the patients' list from the main screen. 

Once a patient is selected, the program transfers us to the list of available 
exercise protocols. The list contains the protocols designed for the ergometer selected 
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from the devices list. Once the protocol is selected, the program proceeds to the main 
examination view. 

 

 

Fig. 15. Commencing an examination 

 
The main view may be changed prior to commencing an examination, by 

expanding the “View” drop-down menu in the top screen ribbon, and confirming with 
the “Apply view” button. The examination is initiated using the green "Start” button. 

 
 

 

Fig. 16. The table with desirable values included. 

 
 

The ergospirometry program resets the measuring device. Remember that the 
patient's conduit may not be moved and no air movement may be caused near the 
conduit until the reset process is finalized. The conduit must be detached from the 
mask and the patient. 
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5.4.2. A combined test (ergospirometry and exercise ECG) 

If an ergospirometric examination is to be performed combined with ECG 
measurements, the “New examination” must be selected on the main screen. The 
program transfers us to the patients' list where a patient may be selected or a new 
patient added using the “Add new” button. A new patient may also be entered without 
initiating an examination, by entering the patients' list from the main screen. 

Once the patient is selected, the program proceeds to the main examination 
view. 

The main view may be changed prior to the examination, by expanding the 
“View” drop-down menu in the top screen ribbon and confirming with the green 
“tick”. The examination is initiated using the green "Start” button. The ECG program is 
executed and current patient's data is transferred to the program only when the 
button is used.  

The ergospirometry program resets the measuring device at the same time. 
Remember that the patient's conduit may not be moved and no air movement may be 
caused near the conduit until the reset process is finalized. The conduit must be 
detached from the mask and the patient. 
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6. Options of the performed test. 

6.1. Examination stages. 

Each examination consists of two stages: a control stage marked as phase "-1” 
and the test stage (phases: 0, 1,2…). Operations necessary to prepare the spirometer 
for work are completed during the control stage. These include among others the 
memory reset, ventilation and the measuring system reset. Following these 
operations, the program proceeds to the analysis state in the control stage (with its 
measured values not saved in the memory). The user must ensure at this stage that 
the program behaviour is correct, i.e. charts are generated using the selected 
parameters and parameter rows are added to the bottom table. The proper 
examination procedure is performed at the test stage and is divided into the reference 
(rest), exercise and recovery phases.  
 
NOTE!!! 
1). The control stage (phase "-1”) is crucial for ensuring the correct performance of the 
examination and obtaining reliable results at the proper examination stage, because 
the ventilation and measuring reset process is completed at the control stage. The 
connection conduit of the pneumotachographic head must be removed as far as 
possible from the mouth of the patient and the operating staff, because the high 
sensitivity of the systems used to measure ventilation and exhaled gas concentration 
may lead to a false zero being read and saved from the ventilation measuring module 
and CO2/ O2 gas analysers. 
2). In the control phase of this stage, when the program already activates the analysis 
system, the triple connecting air conduit must be connected to the 
pneumotachographic head installed on the measuring mask previously put on the 
patient. The third conduit of the triple air conduit, marked with a blue ring, must be 
attached to the connector installed in the mask coupling. 
3). The data displayed on the screen in the control phase is removed at the time of 
transition to the next stage, that is the reference phase (market with the "0” number). 
From this moment on, the examination is saved in the memory of your computer until 
the examination is stopped. The reference phase is usually set to 15 minutes, but the 
user is free to decide when to proceed to the next phase, i.e. the first exercise phase. It 
is recommended that the reference phase last for at least 3 minutes, to correctly 
compute reference calorimetry parameters. 
4). Exercise phases (numbered: 1, 2, 3, 4…..) are changed automatically, according to 
the selected protocol. If the need to discontinue the examination occurs, the user is 
free to decide on the transition to the recovery phase. The phase is set to 15 minutes 
as a standard, but the decision to discontinue the phase and thus the entire 
examination, depends on the assessment and needs of the user. 
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6.2. Examination phases. 

 
The examination phases contain information about test parameters covering 

the entire examination time. This information includes: phase name, its duration, 
patient's workload, the speed and slope of the treadmill (if used in the examination 
procedure). The examination may consist of any number of phases.  

 

 

Fig. 17. Examination phases. 

The “Phases” segment displayed in the top ribbon of the screen is used to 
control exercise phases during examinations. The segment consists of the following 
components: 

 

 The “Phase” window displaying the number of currently selected phase 

 The progress bar – graphically showing the moment of examination 
phase. The time remaining until the end of the phase is displayed next 
to the progress bar in seconds. The name of the phase performed is 
displayed below the progress bar 

 The “Next” button is used to skip to the next phase. Remember that the 
exercise phases change automatically with the lapse of their time 

 The “Last” button is used to discontinue the exercise phases and 
proceed to the last (recovery) phase.  

6.3. Chart view 

Two types of chart views are available in the program. These include parameter 
chart views and On Line curve views. A sample chart view format is shown on figure 
18.  
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Fig. 18. Chart view 

The view contains four parameter charts in this example. A separate vertical axis is 
assigned to each parameter. The vertical axis usually represents time, but may also 
represent another quantity. The parameter charts to be included in the view are 
selected in the “Edit” menu in the top screen ribbon. Additional options for the charts 
are made available by clicking on the chart with the right mouse button. The context 
menu of the chart view is then displayed. 

6.3.1. Context menu of the chart view 

The following options are defined here: 
 

 Comment – enables the user to enter a comment in any point of the 
chart. The comment is associated in the data table with the 
corresponding breath and its time 

 Chart wizard – activates a tool designed for advanced editing of chart 
properties 

 Set AT / RCP / AeT– manual entry of AT, RCP and AeT thresholds  

 Set as default – used to save the chart layout and use it to create 
customized views 

 

 

Fig. 19. Context menu of the chart view 
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6.3.1.1. Comment 

The Comment option marked in the context menu of the chart view enables the 
user to enter an individual comment displayed as a cursor on the examination chart. 

 

Fig. 20. Dialog box for selecting parameters in the chart view. 

 
 
 

6.3.1.2. Parameters 

To define the parameters to be displayed in the selected view, click on the 
chart view to have its frame backlit as an active one, and then select the “Edit” tab in 
the top screen ribbon. Three drop-down menus will be displayed enabling the user to 
select: the Y axis, the X axis parameters and the norms. 

When the "Axis X” menu is displayed, the user is enabled to select any number 
of parameters to be included in the chart and deselect undesirable parameters. The 
selection is confirmed using the “Apply” button next to the menu. 

The “Norms” menu is used to select the norm bar for certain parameters and to 
display the bar on the chart. 
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Fig. 21. Parameter selection menu 

6.3.2. Chart options 

6.3.2.1. Changing axis scale. 

The scale on the chart may be easily changed using the mouse scroll. The chart is then 
enlarged, and scrollbars are displayed on the edges of the chart window, used to 
navigate in the previously enlarged chart. 

6.3.2.2. Synchronizing the table with the chart (the "Follow" function) 

The “Follow” function is used to view the data in detail. It is a binocular-shaped icon, 
displayed in the left top corner of the screen when the data table header is clicked on. 
Use the icon to select any point on the chart with the cursor, and only one row will be 
displayed in the table, corresponding to the point selected using the cursor. Click on 
the binocular icon again to deactivate the “Follow” function. 
 

6.3.3. Table 

A sample table view is shown on Fig. 22. 
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Fig. 22. Parameter table. 

The table contains the values of selected parameters at individual time moments 
during the examination. Each row corresponds to the values of subsequent breaths 
taken, unless the option of averaging in time has been activated in the table. The user 
is enabled to edit the table view: to modify column widths, the order of columns 
displayed, add or remove the parameters displayed. To permanently save the changes 
in the table view, save the current view or save the table. 
 

6.3.4. Table view options 

 
The simplest operations during table view editing include: changing column widths and 
the order of columns. To change column widths, simply grasp, using the mouse button, 
the division line between the column headers, move it in the desired direction and 
release the mouse button. 
 
To change the location of a column, grasp the header of the column using the mouse 
button, drag it to another location in the table and then drop. 
 

6.3.4.1. Editing table parameters 

 
To add or remove parameters in the table, go with the mouse pointer to any 

table header and click on it with the right mouse button. A context menu will be 
displayed, as shown on the figure below. 
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Fig. 23. The context menu of table options 

The most important of these options include "Remove This Column", used to 
delete a parameter, depending on the header clicked on with the right mouse button, 
and the "Column Chooser" that opens an additional window where new parameters 
(columns) may be selected 
 

 

Fig. 24. Dialog box for selecting parameters in the table. 

To add a new column to the table, firstly find the desired parameter on the list, then 
"grasp" it using the mouse button and drag to the appropriate location in the table. A 
similar step may be taken in the opposite direction when we wish to remove a column. 
To complete this task, grasp the column header and drag it to the parameter selection 
window. 
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6.3.4.2. Averaging rows in tables and on charts 

The program enables the user to display averaged results in the table and on 
charts to improve legibility and transparency of the examination saved. The averaging 
function may be set as follows: 

 No averaging – the rows in the table are organized "breath by breath". 
This is the original and basic format of result presentation 

 Averaging after time – the program computes a mean value for defined 
time intervals. The intervals are freely definable by the user 

 Averaging for a phase – each row corresponds to the mean value from a 
single phase, i.e. the number of rows in the table is equal to the number 
of exercise phases in the protocol 

 Averaging for measurement – averaging by the number of breaths. 
Unlike in the averaging after time function, here each row corresponds 
to a defined value of measurements, regardless of their time 
(remember that time intervals between breaths are never uniform) 

 
To select the averaging method, click with the mouse button on the table header. 
Table editing icons will be displayed in the top screen ribbon. 
 

               

Fig. 25. Averaging a table and saving a table view 

Expand the drop-down menu in the "Averaging" section and select the averaging 
method. If the "Time" option is selected, the user is enabled to freely select the time 
interval for averaging. Similarly, in the "Measurement" option, the user is enabled to 
select the number of consecutive breaths covered by the averaging operation.  

6.3.4.3. Saving table view 

Each table view may be saved for the future as a file. The icon "Save table view" 
is used for this purpose. The saved view may be used at any time, by clicking on the 
"Load table view" option. The table layout is saved with the complete screen view, so 
that the view saving option is also available. 

6.3.4.4. Editing and deleting table data 

Data may be edited in the table directly, by pointing to a selected cell and 
changing its value. Remember that not all changed details will be saved, but only those 
classified as "original" values. If a parameter is calculated as a function of other original 
parameters, the program will not accept the result of its editing. 
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If data for a longer period is to be edited, e.g. heart rate (HR) for a time interval 
of several minutes, mark the entire range in the column, using the mouse 
button, and then activate the "Input new value" function available in the top 
screen ribbon. 
 

 

Fig. 26. Editing and deleting data 

 
Enter the desired value in the text box and press "Enter”. The program will update data 
in the selected rows within seconds. 
 
Selected rows (e.g. artefacts) may be removed from the table using a similar method. 
Mark the desired data range in any column and then click on the "Delete selected 
rows" icon. 

6.3.4.5. Exporting a table to external applications 

To export a table to another file format (e.g. spreadsheet), open the "File" tab 
in the top ribbon and click on the "Preview" icon.  

 

 

Fig. 27. Table preview 

 
The table preview will be displayed where the user may print the table or use the 
export function. Click on the green floppy-disk icon for this purpose, as shown on the 
figure below: 
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Fig. 28. Averaging results in the table dialog box 

A menu will be displayed where the user may select the target file format to save the 
examination results. 
 

6.4. Find AT / AeT / RCP threshold 

The manual method or the automated mode may be used to find those 
thresholds. Using the first method, the thresholds may be determined in almost all 
charts in the program, by clicking on a location with the right mouse button and 
selecting the "Insert threshold..." option”. (Fig 31).  

The program is capable of automatically identifying the thresholds. Click on any 
chart or table. The tools for automated examination analysis will be displayed in the 
top screen section (Fig. 32) 

 

 

Fig. 31. Manual edition of AT / RCP / AeT thresholds 
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Fig. 32. Threshold and CPET report editing tools 

 
Select the "Find" AT, RCP…. threshold button The program will automatically identify 
all 3 thresholds, if possible. Please pay attention to use “refresh” button after this 
action, if You want to have Your CPET report actual.   

6.5. Delete the AT / AeT / RCP threshold 

To delete the AT or other thresholds, You may use the manual tools (Fig. 31) in 
the same way as described in chapter 6.4. You may also delete all three thresholds 
using the tool from chapter 6.4. (fig. 32). To have all changes resulting from table and 
threshold editing included in the report and CPET calculations, use the "Refresh" icon. 

 

6.6. CPET Report 

 
One of the most popular formats of presentation of ergospirometric examination 
results is the CPET report. The report contains a set of the most important parameters, 
calculated based on the examination, defined for its individual stages, such as the rest 
phase, the moment of reaching the AT threshold or the VO2max. 
 
The results are compared with desirable values calculated based on statistics. 
 
The CPET may be obtained in the program using 2 methods: 

 Select the CPET view in the view menu in the "View" tab 

 Expand the "Report CPET" tab in the bottom section of the screen 
 
NOTE! Remember to use the "Refresh" function, to have the data contained in the 
report updated taking into account the most recent changes.  
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7. Performing the examination 

7.1. Preparing the examination 

Checking the device to ensure the correct functioning of all measuring components is a 
condition necessary to begin an examination. The check is made available as part of 
the calibration procedure of gas analysers and ventilation measurement system 
(Section 5.2). We recommend that the device be calibrated prior to beginning a cycle 
of examinations on each day. 

The only command available during the examination is to discontinue the 
examination (the Stop command in the Examination menu). This prevents other, 
incorrect methods of discontinuing work with the program (e.g. closing the program 
during an examination). The entire examination procedure may be summarized as 
follows: 
 

1. Complete a check of the device to ensure that people are protected against 
electric shock, by visually inspecting the condition of all electrical cables. 

2. Complete daily service tasks following the instructions contained in Section 
"Maintenance and daily service”. 

3. Switch on the device using the mains switch located in the front panel of the 
device. 

4. Leave the device switched on for at least 30 minutes, so that the measuring 
components can achieve their thermal stability. 

5. Run the VO2 Viewer program. 
6. Complete volume and gas calibrations. 
7. Enter patient's data ( Section 4). 
8. Select a suitably sized measuring mask for the patient, ensuring tight contact 

between the mask and the patient's face skin. 
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NOTE! 
a.) Attach the pneumotachographic head to the mask before it is put on the 
patient; 
b.) Remember that the connection conduit of the pneumotachographic head 
may not be connected to the head until the process of automated reset of the 
measuring system is complete; 

 
9. Begin the examination by clicking on the "New examination" icon. 
10. Perform the examination in accordance with the description applicable to the 

examination type.  
11. Finalize the examination using the Stop button (the button with a red circle). 

Save the examination. 
12. To begin another examination, the user must close the open examination. 

Proceed as above, starting with item 7. Patient's data refer to the last patient. 
 

NOTE! 
a.) The connection conduit of the pneumotachographic head may not be 
connected to the pneumotachographic head attached to the mask; 
b.) The connection conduit of the pneumotachographic head must be removed 
as far as possible from the mouth of the patient and the operator of the 
ergospirometer!  
c.) Once the reset process is complete, the measuring system proceeds to the 
control phase and now the connection conduit of the pneumotachographic 
head is to be connected to the head and the connector in the mask; 
 

7.2. Entering parameters from the spirometry procedure 

To enter the parameters from the spirometry procedure most recently 
performed for the patient, expand the “Patient” tab in the bottom section of the 
screen. Its contains 4 fields designed to enter values from the spirometry procedure: 
FVCEX, FEV1, MEF50 and MVV. The data is useful in calculating certain quantities 
contained in the CPET report. 

 
 

7.3. Reading an examination from the database 

 
To read and edit results saved in the database, select the "Examinations" 

button in the top screen ribbon. The program will display a list of all examinations 
organized by date and time of their performance. One of the columns contains 
patients' names and is used to easily sort the table by names, by clicking on the header 
of this column.  
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Note: the database enables the user to filter examinations by a specified date 
range. Default filtering is set to the last 3 months. To view older examinations, activate 
the filtering function by clicking on the "Date" button and then using the "Refresh" 
function. 

The list of examinations may also be displayed for a single patient, by starting 
from the “Patients” tab. Mark the patient's name and click on the examination button 
to obtain a list of examinations performed for this name only. 
 

7.4. Printing the report on examination 

The examination results may be printed upon its completion or once the 
examination has been loaded from the database. To print the report. select the 
Printings command in the File menu. The selection and configuration screen for report 
printouts will be displayed. Its left section contains a list of available report 
configurations. To print the report, mark one of them and click on the preview button 
in the bottom section of the screen. A printout preview will be displayed that can be 
printed using a selected printer.  

 

 

Fig. 34. The Printings dialog box 

7.4.1. Printout settings 

To add a page to the report, enter an additional row in the “Page” window, defining 
the division of the page into selected numbers of rows and columns. The number of 
rows must be selected so as to contain individual components within the page. 

 
The next step is to define the components to be included in the page. Their list 

is created in the right bottom window of the configuration tool. The number of 
components must be consistent with the number of rows and columns declared in the 
"Page" window 
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Fig. 35. Selecting printout components 

The component type to be inserted must be defined in each consecutive row in 
the first place. It may include a chart from examination, a table saved as a file, the 
CPET report or an inserted text fragment.  

If a chart is selected, indicate the source of the chart in the "View" column. The 
drop-down menu includes a list of views saved in the program and charts associated 
with them. 

If "Data" is the selected component, i.e. a result table, the source file with the 
table must be indicated in the second column. An averaging value may also be defined 
for the table, other than the averaging value previously defined in the examination. 
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8. AT threshold searching criteria 

If the user wishes to define an AT threshold, a number of options facilitating 
this task is offered in the AT threshold determination mode. The first chart makes 
available an indicator (a vertical line) that may be moved horizontally (along the time 
axis) using the mouse pointer (the indicator becomes "attached" to the mouse pointer 
as soon as the pointer is moved to the area of the first window). When the indicator is 
moved within the exercise phases (two vertical orange lines – only if the grid is 
displayed), the two regression straight lines change their positions on the second 
chart. They refer to two data areas. The areas are created by dividing the entire data 
set in the point marked by the indicator in the first window. The regression lines 
facilitate the identification of the largest inflection point on the chart of VCO2 as a 
function of VO2 (a suspected point of the AT threshold). In addition to the regression 
lines, an indicator (a vertical line) is also drawn in the second window, indicating the 
point corresponding to the location indicated in the first window. A similar indicator is 
also drawn in the third window.  

 

8.1. Non-invasive methods for determining the anaerobic 
threshold 

 
 
Equivalent method with an additional analysis of final-exhalation oxygen and carbon 
dioxide pressures 
 

 
Slope method 
 
 
VCO2/VO2 
It consists in controlling the relation between VCO2 and VO2. 
AT is the event of occurrence of such a VO2 value at which the slope increases in the 
relation curve between VCO2 and VO2 that is relatively linear, and previously, during a 
graded examination protocol, its slope is indicated by the S1 line (Fig. 2). The 
examination intensity increases, and consequently the slope also increases in the curve 
representing the relation between VCO2 and VO2, as marked with the S2 line on Fig. 2. 
 



VO2max Tracker System User Manual 
. 

 47 

 
 
 
The double method 

 

To minimize the error in determining AT, use both methods at the same time (the 
double method), at RQ approximated to 1. 

 
To confirm that the slope change is not accidentally caused by hyperventilation, it is 
necessary to monitor O2 and CO2 equivalents. Consequently, the ventilation 
equivalent EQO2 reach their lowest values and then begin to increase in the S1-S2 
transition point without any increase in the EQCO2 equivalent. The slope method 
proposed by Beaver is complex (correlation for CO2 transport changes, at a distance 
from the lungs, data filtering, mathematical calculations required by a computer 
analysis), and has been replaced with a simplified method in more conventional 
systems, The modified slope method defines, consecutively, the point of slope change 
in the relation between VCO2 and VO2 and determines the VO2 value above which the 
increase in VCO2 is faster than in VO2, without hyperventilation. 
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9. Maintenance and daily service. 

1. The masks must always be clean and the mask duct connected to the air 
conduit must be unobstructed. 

2. The masks and pneumotachographic heads should be changed following each 
examination, so that the patient obtains a sterile mask and head. 

3. The masks and mouthpieces may be sterilized using a gas sterilizer or fluids 
(CIDEX or ALDESAN). 

4. The sterilization process in fluids is carried out by immersing the masks for 2 
hours, and then carefully rinsing them with distilled water and drying. The 

drying temperature may not exceed 65 C 

5. Following the sterilization and drying processes, the masks and heads must 
be checked to ensure that the air ducts are not obstructed. 

6. Earthing and equipotential connections: VO2max Tracker is an apparatus 
conforming to the B2 class of electric shock protection. Consequently, no 
earthing of the apparatus is required, but it may be useful in preventing 
disturbances originating from the power supply system. The power supply 
cable is equipped with a neutral conductor (the central terminal in the supply 
cable socket and plug). If grounding in the power supply system is uncertain, 
the apparatus may be connected to an earthing system conforming to the IEC 
standard, using an earthing cable. The earthing cable must be connected to 
the device using the earthing socket located in the rear panel of the 
apparatus. Attention. Earthing cables are not equipotential cables.  

7. Replacing the fuse. A 1A 220V 50Hz fuse is located in the drawer socket of 
the power supply switch in the rear panel of the apparatus. To replace the 
fuse, disconnect the power supply cable, and then pull out the drawer with 
the fuse. Attention. Only fuses with parameters consistent with those given 
in these instructions may be used. 

NOTE!!! 
The recommendations contained above must unconditionally be 

followed! 
A failure to follow the foregoing recommendations may cause 
damages to the apparatus, lead to erroneous results of performed 
tests and to infections in the examined patients. 
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10. Appendix A 

10.1. O2 kinetics analysis  

 
VO2 kinetics, the O2 deficit, O2 debt represent important indicators of tolerance to 
exercise and of sports achievements. Under "normal" O2 convection and diffusion 
conditions, supply of oxygen to skeletal muscle fibres does not provide important VO2 
kinetics indicators. 
Consequently, under "normal" conditions (e.g. normoxia, no obstacles in oxygen 
supply, no pathological conditions), the factors limiting VO2 kinetics seem to be those 
located in muscle fibres. Important VO2 kinetics indicators in skeletal muscle fibres 
probably lay in interactions between various mechanism of energy supply during 
increasing exertion.  
The varying "locations" of the main factors limiting the VO2 kinetics and the VO2max 
value offer the physiologists of exertion the opportunity to complete non-invasive, 
functional assessments of the oxidation metabolism at two various levels of paths 
securing O2 supply, from the atmospheric air to the mitochondria of exercise muscles. 
In other words, by measuring the VO2max, we assess principally the functional 
capacity of the cardiac circulatory system in term of supplying O2 to the muscles 
involved in exercise while the determined VO2 kinetics refer, through a functional 
assessment, principally to the oxidation mechanism of skeletal muscles. In pathological 
conditions, the circumstances may be less clear. 
It has been confirmed that pulmonary VO2 kinetics are slower (than normal) in 
patients with documented pathological conditions, such as chronic obstructive 
pulmonary disease, cardiac embolism, peripheral vascular diseases, type II diabetes, 
etc. Does it mean that the reduced capability of the lungs, heart, blood vessels of 
supplying O2 to the muscle involved in exercise may be responsible for O2 kinetics 
being slower than normal? The answers to those questions are not simple. The 
proposition that a limited capability of supplying muscles involved in exercise with O2 
entails slower VO2 kinetics is confirmed by experiments on patients with acute 
hypoxia, on patients performing arm exercises, on patients performing leg exercises in 
a supine position, on patients treated using blockers and others. Under all those 
conditions, slower pulmonary VO2 kinetics were recorded with an accompanying (or 
resultant) reduction in O2 supply to the muscles involved in exercise. On the other 
hand, there is a growing body of evidence that in patients with chronic diseases of the 
heart, lungs or blood vessels as well as in patients with diabetes, the metabolism in 
skeletal muscles is changed and plays a key role in determining a reduced tolerance to 
exercise. All patients with transplanted hearts demonstrate slower pulmonary VO2 
kinetics which results from a reduced innervation of the transplanted organ and an 
accompanying reduced systole frequency and slower cardiac output kinetics.  

 
 



VO2max Tracker System User Manual 
. 

 50 

10.1.1. O2 kinetics in the stress phase 

 
The oxygen consumption in the period from rest to exercise in a steady state may be 
defined by three phases or states (Figure 1). 
Phase 1 may be defined as a metabolic response during the first twenty seconds of an 
exercise test.  
Gaesser and Poole define Phase I as an increase in VO2 caused principally by an 
augmented cardiac output and pulmonary blood flow. In Phase II, the kinetics is 
described by the τ time constant that is the time necessary to achieve 63% of Δ VO2 
increase in a steady state and is characterized by an exponential rise in VO2 just after 
the beginning of Phase I. Increased venous return from the exercising muscle as well as 
continued pulmonary blood flow denote Phase II kinetics. Gaesser and Poole (1996) 
also suggest that the Phase II kinetic response is relatively constant in the transition 
from rest to steady state during exercise of light to moderate intensity (below the LT 
lactate threshold). 
Moreover, increased levels of physical fitness (VO2 max) may lead to a faster τ. τ may 
also be delayed as a result of increased exercise intensity and probably facilitates an 
oxygen drift.  
 

 
 

Figure 1. 
VO2 response to exercise with a constant workload; the curve in dotted line, 
generated by the computer, is a representative, best matching, strongly exponential 
VO2 response model; the first dotted vertical line (t=4min) shows an increase in 
exertion, the second (t=10min) – the end of exercise and the beginning of the 
recovery phase 
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The response in the second phase (τ) is determined using the following formula: 

  

 VO2(t) = ΔVO2 x (1 - e–t/τ )  
where VO2(t) represents the VO2 value above the base line increasing at each moment 
(t); 
Δ VO2 represents the difference between the VO2 value in Phase I with a sign in the 
20th second and the VO2 value in a steady state (Phase III);  
e is a natural logarithm;  
τ is the time to achieve 63% of ΔVO2. 

 
 
The value describing O2 increase kinetics: 

 

τ(63% ΔVO2) - τ is the time to reach 63% of ΔVO2 
 

10.1.2. O2 recovery kinetics 

In the recovery phase, VO2 decreases exponentially after gradually increased 
workload. The half time for VO2 in the recovery phase (T0.5) is 60-80s for normal 
patients after gradually increased exercise. VO2 kinetics becomes longer with 
increasing heart disease severity. The patients with a value h a VO2peak< 10-12 
ml/kg/min may need 3 minutes to reach VO2 value reduction to 50%. This probably 
reflects the reconstruction of energy reserve after exercise. The advantage of post-
exercise VO2 kinetics results from the fact that the results depend to a limited extent 
on the intensity level of exercise, and thus a kinetics analysis may also be useful if the 
test was sub-maximal, i.e. VO2>50% VO2max. VO2 kinetics may be used to analyse and 
assess the degree of circulation disorders. The normal value of VO2 at a low VO2 peak 
value suggests sub-maximal exercise. The half time for VO2 in the recovery phase is 
important for medical prognoses. 

 
Values describing recovery O2 kinetics: 

 
T0,5VO2peak (s) time to reach 50% VO2peak in the recovery phase 
τ(63% ΔVO2) (s) a time constant of the oxygen consumption increase curve 

during exercise with a constant workload, for which the 
increase in VO2 value reached 63% of the VO2max value 
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10.1.3. Calculating O2 deficit and debt 

 
The oxygen deficit is defined as the difference between the total energy costs of work, 
understood as required during the exercise period in a steady state, and the measured 
portion of total energy output that took place during the exercise period at aerobic 
energy production. The deficit may be directly associated with the VO2 steady state. 
Therefore, if the steady state is reached sooner, the identified oxygen deficit is lower. 

 
 
Figure II 

Oxygen deficit and debt during exercise with a constant workload below the 
anaerobic threshold (AT) 
 

VO2.T.SUM [L]  the total volume of oxygen during the entire test (gross); 
VO2.OD.SUM 
[L] 

 the total of accumulated oxygen deficits: the difference between 
the O2 consumption product in a steady state during exercise 
and the total current oxygen uptake by the body during exercise 

VO2.L.SUM [L]  the total volume of oxygen consumed during the exercise 
phases (net); 

VO2.R.SUM [L]  the volume of oxygen used in the recovery phase (net); 
VO2.A.SUM [L]  VO2.A.SUM = VO2.OD.SUM - VO2.R.SUM – the total of 

anaerobic oxygen consumption; 
VO2.B.SUM [L]  the volume of oxygen consumed in the test, calculated at the 

level of consumption from the reference phase (tare); 
VE.B.SUM [L]  the total volume of breaths during the test calculated at the 

reference phase level (tare); 
VE.T.SUM [L]  the total volume of breaths in the entire test (gross); 
VE.L.SUM [L]  the total volume of breaths in the exercise phases (net); 
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VE.R.SUM [L]  the total volume of breaths in the recovery phase (net); 
 

10.2. Basic recommendations for the optimum selection 
and preparation of rooms for ergospirometric examinations 

 
 minimum room area 16 m2 
 

 a well ventilated room with a stable temperature throughout the year (air 
conditioning)  

 

 floor finished with an anti-static material, easy to clean and not slippery 
 

 power supply with a good earthing system or secure equipotential bonding, suitable 
for installing loads of 3-8kW (such as treadmills, bike ergometers) 

 

 the best solution is to equip the room with a three-phase wiring system 3 x 400V/20A 
(but only if equipment that requires this type of power supply is to be purchased) 

 

 a room with a defibrillator and a couch (may be located in an adjacent room) 
 

 a good practice is to use 2-3 communicated rooms (a small cloakroom with a shower, 
or at least a washing basin and a toilet, and a room with a couch) 

 

 door width even up to 140 cm to facilitate equipment transportation to the room 
 

 room location at the lowest level possible, preferably at the ”0” level to ensure easy 
transport from the outside, in particular for disabled people, and to facilitate 
equipment supplies for exercise examinations 

 

 minimum room height 300 cm 
 

 


